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Introduction 

Welcome to Easy Way Word 2013 Level 1.  

This is a complete step-by-step beginners book which teaches the creation of documents, 
saving, printing, viewing, editing, moving/copying, spell checking etc. Fonts are applied and 
paragraph formats are used as well as page layout techniques (changing paper sizes, page 
numbers etc).  Basic file management is also included.   

This book has been written using Microsoft Word 2013 with Windows 8. (The Windows 7 
operating system can be used. However screen shots will differ slightly from those shown in 
this book.) 
 

Default Settings 

Before commencing this course you will need to check (and amend if necessary) the default 
settings for Word 2013 as described on pages vii to ix.  This will ensure that all exercises and 
instructions in this book will work exactly as they should.   
 

Retrievable Exercise Files 

Some exercise files have been created for you to prevent time in keying in many exercises.  You 
can then open these files and use the features of Word to manipulate and format text.   

A list of these files is shown on page xiii and instructions for downloading these files from our 
web site are included on page xiv. 
 

What you will learn 

In this course you will learn to - 

 Interpret and understand the Microsoft Word 2013 screen and options 

 edit, format, manipulate, save and print documents 

 manage files and apply data security procedures  
 

How you will learn 

This book is divided into sections.  Each section page lists the learning outcomes for that 
section.  You will work through each section and do all exercises (or those instructed by your 
tutor).   

Consolidation exercises are included at the end of the section followed by Skills Tests.  Our 
books include accumulation and consolidation of learning which carries across each section.   
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Word meaning boxes 
Sometimes you will see a box at the left side of the page of a line that has dotted underlining. 
This box will contain information to help you understand the meaning of the underlined word 
(or how that word is formed).  An example is shown below. 
 
Data can therefore be altered to re-calculate budgets and to forecast results using different 
sales figures.  Worksheets can be saved, opened and printed as required. 
 

Different Word buttons 
Depending on the size of your Word screen buttons on the ribbon may vary to those shown in 
this book.  The icon with the word of that feature may show, or the icon only. 
 

For example, the Copy button in the Clipboard group on the Home tab may be displayed in 
either of the following ways. 

  OR   

The Symbol button can show as either - 

 OR  

Shortcut keys 
Shortcut keys are indicated in the left margin, usually the first time they are used.  An example 
follows. 

1 Click on the Save button  on the Quick Access Toolbar  . 

2 Type a file name for your document then click on Save.  

Glossary 
Generally when a word(s) is first used that is a technical term or a word that you may not know 
that relates to an exercise, or a particular Word 2013 feature, a description is given.  You will 
also see that such words are in bold.   

These terms are listed on each section page, an example is shown below.  Explanations are also 
included in the Glossary at the end of the book. 
 

 

 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

AutoCorrect Format Replace 
Clipboard Microsoft Office Help Selecting Text 
Correction Signs Move Text Synonyms and Thesaurus 
Cut Navigation Pane Typing Replaces Selection 
Drag and Drop Proof-reading Undo 
Find Redo  

 

forecast  
=  to 
calculate a 
future 
result  

Ctrl S 
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Icons used in this book 

This book contains icons to help guide you in your learning.   

The following list shows the icon and its meaning. 

 

 Learning Outcomes 
Learning Outcomes are displayed on the section page and describe what you will learn in that 
section. 

 
 

 EXERCISE 1 
These are the exercises that you are required to do.  Often there will be an introduction 
sentence to tell you what you will be doing in that exercise.   
 
 

These are notes for your information. 

 
 

 Consolidation Exercises 

This appears at the end of each section and contains consolidation exercises relating to features 
learnt in that section. 
 
 

 Skills Test 

Each skills test covers consolidation of topics learnt in that section and provides further 
practice. 
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Changing Defaults 

Default settings may have already been changed in your Word 2013 program.  If not, you can 
use the following instructions to change these. 

Font and Font Size 
You can check if the font and font size have been changed by looking at the Font box on the 

 tab.  If it shows  then it has not been altered.  Change the default 
font to Arial 11 pt as follows: 

1 Click on the Font Dialog Box Launcher  which will display the 
Font dialog box. 

2 Change the Font: to Arial and the Size: to 11 pt. 

3 Click on . 

4 Ensure the following option is selected for the font to be applied to All documents based 
on the Normal template.  

 

5 Click on OK. 
 

Spacing 

 Click on the  tab and if 10 pt Spacing After is displayed as shown below then 
this has not been altered.  (Use the instructions below also if 8 pt After is displayed.) 

 

Remove 10 pt spacing as follows. 

1 Click on the Paragraph Dialog Box Launcher  which will 
display the Paragraph dialog box.   

2 Change the Spacing After: to 0 pt as shown below.  

 

3 Click on .   

4 Ensure All documents based on the Normal template is selected then click on OK.   
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Margins 

 On the  tab click on the Page Setup Dialog Box Launcher 
 which will display the Page Setup dialog box.   

If margins are displayed as 3.17 cm change them as follows.  (If they have been changed to 
those shown below click on Cancel.) 

1 The Top: margin will be selected, ie .  Type:  2.54 then press the Tab 
key.  Repeat this until the margins are displayed as shown below. 

. 

2 Click on .   

 

3 Click on Yes.   

 

 

Bullets and Numbering 
When bullets and/or numbering are inserted in Word 2013 a style is applied to these features.  
This can prevent spacing before and after, or spacing options to be used with the Line and 
Paragraph Spacing button.   

You will therefore change bullets and numbering to be applied using the Normal style as 
follows: 

1 Click on the  tab and select . 

2 Click on  at the left. 

3 Ensure a tick is displayed in the following . 

4 Click on OK. 
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Dictionary 
Microsoft Office 2013 does not have an inbuilt dictionary.  We recommend that you download 
the Bing Dictionary as instructed below.  

(If another dictionary has already been added captures in our Word 2013 books will be very 
similar but may not be exactly the same.) 

You will need to be connected to the Internet to be able to download the dictionary and to use 
it. 
 

1 Click on the  tab then click on . 

2 In the Apps for Office dialog box click on which will take you to the 
Microsoft Apps Store.   

(If other apps have been installed you need to click on . 

3 In the Search box at the top of the window type dictionary as shown below. 

 

4 Click on the Search button . 

5 Click on the following dictionary which we have selected because it is FREE and has the 
highest star rating.  It can also be used in Excel 2013. 

 

6 Click on  then on  

The Bing Dictionary will now show on the  button and will be used for spelling and 
grammar checking, synonyms and thesaurus. 
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Save Options 

When a document is saved you will be requested to select the location, ie Computer then click 
on the Browse button and select the folder required.  You can eliminate this procedure by 
selecting the location and saving directly to the Save dialog box and therefore bypass Backstage 
view.   

For the purposes of this book we have used My Documents folder as the default folder.  This 
means that files you open and save will be on your hard drive. 

 

If you wish to open and save files to SkyDrive (ie the cloud) use instructions on the next page. 

 
Use the following instructions to specify My Documents as the default file location: 

1 Click on the  tab then click on . 

2 Click on  at the left. 

3 Ensure that the Documents folder is displayed as the Default local file location as shown 
below.   

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a 
tick. 

5 Remove the tick from the next option Show additional places for saving, even if sign-in 
may be required. 

 

6 Click on OK. 
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SkyDrive 
SkyDrive is a cloud storage application from Microsoft.  It is one of the major online file storage 
options competing with Dropbox and Google Drive. 

Because files are stored “in the cloud” it means that you can access those files from anywhere 
in the world because you will always have access to the SkyDrive application and your files.  You 
do however need an Internet connection to be able to update those files. 

 

 
Saving to SkyDrive 

SkyDrive is automatically set up when Microsoft Office 2013 (ie Office 365)  
is installed on your computer.  A SkyDrive folder will be displayed on the 
Navigation Pane in Windows Explorer as shown at the right.   

Files can be saved manually by clicking on the Save button  on the Quick 

Addess Toolbar, specifying a name for your file then clicking on the  icon (you may 
wish to double click on Documents and save to that folder). 
 

SkyDrive as the Default File Location 

Use the following instructions if you wish to specify SkyDrive as your default file location. 

1 Click on the  tab then click on . 

2 Click on  at the left. 

3 Ensure that the Documents folder is displayed as the Default local file location as shown 
below.   

4 Also ensure that Don’t show the Backstage when opening or saving files option displays a 
tick. 

5 Remove the tick from the next option Show additional places for saving, even if sign-in 
may be required. 

6 Click on  at the right of Default local file location: and select . 

 

7 Click on OK. 
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SkyDrive Website 

You can log in to the SkyDrive website using your web browser with your login name and 
password. 

The website is www.skydrive.live.com. 

 

You can upload photos and use files and share files. 

New files can be created through SkyDrive by clicking on  and selecting the 
program you wish to use, eg Word (web applications in SkyDrive are slightly cut-down 
versions of Office 2013 programs). 

 

 
Sharing Files 

From within Word 2013 you can save files to SkyDrive (usually to the Documents folder).  You 

can then click on the  tab, on  and invite people to share files in SkyDrive.  (For 

further information click on the Help button  in the Share screen.) 

Alternatively, you can right click on a file in the SkyDrive website (see above) and select Sharing. 

Use Google in your web browser to search for additional information on SkyDrive.  
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Exercise Files used in this book 

 
(Instructions are included on the following page for downloading retrievable files 

from our web site at www.cherylprice.co.nz) 
 
 

Names of files 

Africa History and Rules of Tennis 

Africa-1 Jacob and Sons – Sales Personnel 

Appliances Macroworks 

Appliances-1 Mobile Phone Specialists 

Balloon Gifts Owning a Cat 

Brick Bay Sculpture Trail Owning a Dog 

Buying a Boat Package Prices 

China Pohutukawa Retreat and Sanctuary 

Computer Wizz Limited Scuba Diving 

Cookery Book Suzannah’s Cookery Book 

Cruises Tour de France 

Cruising the Murray River Training Requirements-1 

Educational Systems Travelers 

Fabric Wholesalers TRIATHLON-1 

Fiji Retrievable What is an iPod 

Health  
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Downloading Exercise Files 

The exercise files listed on the previous page can be downloaded from the Cheryl Price web 
site using the instructions below. 

Exercise files can be downloaded to My Documents folder OR SkyDrive.  However, for the 
purposes of this book we have specified My Documents as the folder for saving and opening 
files.  If you are using SkyDrive simply use the SkyDrive folder instead. 
 
 

  

1 In your web browser, type: www.cherylprice.co.nz 

2 Press Enter on the keyboard to display the Cheryl Price website. 

3 
Click on the Resources tab as shown at the right. 

4 Click on  Easy Way – Microsoft Word 2013   

5 Under the Exercise Files heading click on the underlined blue hyperlink, ie     

Word 2013, Level 1  Free Download 

The File Download dialog box will display.   

6 a Click on then click on the Documents folder shown below at the 
left OR on SkyDrive shown below at the right. 

 

    

b Click on . 

7 a Click on .   

b Right click on the zipped exercise file and select Extract All.  Click on Extract.   

 A folder will be created containing the exercise files.  

c Delete the Compressed (zipped) Folder. 
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The Word 2013 Screen 
Create, Save, Open and Print Documents 
Cursor Movements 
Zoom and Document Views 

 
 

 

 Learning Outcomes 
 

At the end of this section you should be able to -  

 Start and exit Word 2013 

 Identify parts of the Word 2013 screen 

 Understand the ribbon and groups 

 Create, save, open, print and close documents 

 Practise cursor movements 

 Use the Zoom feature and Document View options 

 Minimize, Restore Down and Maximize a document  
 
 
 
 

In this section you will come across the following words highlighted in bold. This 
indicates that the word is included in the Glossary at the end of the book together 
with a description of that word. 

Close 
Cursor Movements 
Customising Formats 
Document Creation 
Document View Buttons 
Draft View 
Editing 
Formatting 
Hard Copy Keyboard 
Shortcut 
Manipulating Text 
Minimize 
Mouse Options 

Mouse Pointer 
Naming 
Outline View 
Previewing 
Print Layout 
Print Preview 
Printing 
Quick Access Toolbar 
Read Mode 
Restore Down 
Retrieval 
Ribbon 
Save 

Save As 
Soft Copy 
Storing 
Taskbar 
Vertical Scroll Bar 
Vertical Scroll Box 
Web Layout 
Zoom 
Zoom In 
Zoom Out 
Zoom Slider 

 

Section 

1 
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What is Microsoft Word? 

Microsoft Word is a word processing program that allows you to create text and/or graphics 
using a keyboard which is displayed on screen (referred to as “soft copy”).  The document is 
then saved onto the hard disk in your computer system.  A document can be opened on screen 
and edited and formatted (as many times as necessary).  A “hard copy” can be produced by 
sending the document to the printer. 

A word processing program generally includes the creation of - 

 General correspondence, eg letters, memos, faxes 

 Reports, travel documents, minutes of meetings, financial documents  

 Advertisements, flyers, brochures 

 Mail merges (ie direct mail), labels, tables 

 Manuals, other documentation 

 

The Process of a Word Processed Document 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 

  
Final copy is printed 

(hard copy) 
 

Document is opened on screen.  It can 
then be edited and formatted, saved 

and resaved as many times  
as necessary. 

Document is printed 
(hard copy) 

 

  

23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
As requested I am enclosing information on Elf 
Computer Systems.   
 
Please let me know if I can be of further 
assistance. 
 
Yours sincerely 
 

 
Sam Corinaldo 
Manager 
 

Document is saved onto the 
Hard Disk inside the  

System Unit OR to SkyDrive 
Text is displayed on monitor 

(soft copy) 

Text is copied from paper 
(or keyed in directly via the 

keyboard onto the  
computer monitor) 

 

  
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  I 
aI am enclosing information as requested by you 
in your email.  Please ddo not hesitate to contact 
me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs 

 
 
 

 

System Unit 
Monitor 

Keyboard Mouse Speakers 

 Dk kfj k kdj kadj kd kadj fkad jkdj 
akljd jasd kaj kadj kadj kdj fkdjf 
kadj kadj kasdj lkasdj klasdj 
lkasdj lksdj fkasdj klsdj fksdj 
flksdj flkasdjf lksdj fkasdj fklasdj 
klasdj lkasdj lkadjf kadjf ak; 

  
23  January 2010 
 
Mr R B Jacobs 
45 Elm Lane 
OREWA 
 
Dear Mr Jacobs 
 
Thank you for your letter of 15 December 2009.  I 
aI am enclosing information as requested by you 
in your email.  Please ddo not hesitate to contact 
me. 
 
Yours sincerely 
 
 
 
Sam Corinaldo 
Manager 
 
Encs  Dk kfj k kdj kadj kd kadj fkad jkdj 

akljd jasd kaj kadj kadj kdj fkdjf 
kadj kadj kasdj lkasdj klasdj 
lkasdj lksdj fkasdj klsdj fksdj 
flksdj flkasdjf lksdj fkasdj fklasdj 
klasdj lkasdj lkadjf kadjf ak; 
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Starting Microsoft Word 

 EXERCISE 1 

1 If the Start screen shown below is not displayed click on the Windows key 
on your keyboard OR move your mouse pointer to the very bottom left of the 
window where the Start button shown at the right is displayed.  
 

 

 

2 Click on  at the bottom right of the screen which will display program options, an 
example is shown below. (Yours will be slightly different and may have more, or less 
programs displayed.) 

 

3 Click on the Word 2013 program icon . 

Click here to scroll 
across the screen 

Click here to 
display the 
Start button 
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Microsoft Word will open.  If Word 2013 has been used previously then Backstage View 
will be displayed as shown below.  (Recent documents are shown at the left.) 

  

4 Click on Blank document as indicated above.   

The screen will display with a new document, ready for you to enter text as shown below. 

 

 

 
 

 

 

 

 

 

 

 

 

 

The  tab contains all basic tasks such as opening, saving and printing a document. 

 
 

File tab 

Group 

 

Rulers 

 

Note:   
If Rulers are not displayed 
click on the View tab then click 

in the Ruler check box. 

 

Quick 
Access 
Toolbar  

Insertion point 

Ribbon 

Vertical 
Scroll Bar 

Vertical 
Scroll 
Box 

Help Ribbon  
Display Options Minimize Restore 

Down 

Close 

Status Bar Document Views Zoom Controls 

Tabs Title Bar 

Rulers 
 

Note:   
If Rulers are not displayed 
click on the View tab then 

click in the Ruler check box 
 

Blank 
 document 
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Quick Access Toolbar  

The Quick Access Toolbar contains commands to Save, Undo and Repeat/Redo.  Other 
frequently used commands can be added to this toolbar.   

 

 
 
 

The Ribbon 

The ribbon in Microsoft Word 2013 is divided into groups and used as described below.   
 

(a) When you click on a tab, groups will be displayed relating to that particular feature, eg the 

 tab displays the groups shown below, ie Clipboard, Font, Paragraph, Styles, Editing. 
 
 

 
 
 

(b) Clicking on a down arrow  displays options for that feature, eg when 
you click on the down arrow at the right of Underline button in the Font 
group underlining options are displayed as shown at the right.  

(c) Clicking on the Dialog Box Launcher  to the right of the group name 
displays the relevant dialog box, from which you can also select the same, 
and additional options, eg when you click on the Font Dialog Box 

Launcher  the dialog box for that group is displayed as shown below.  
(Click on Cancel to remove the dialog box.) 

 

Groups 

 

Tabs 

 

Repeat/Redo 

Save 

Undo 
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 EXERCISE 2 

1 On the  tab click on  in the Page Setup group. 

2 Write down the two options that are displayed 

 ................................................................................................................................................  

3 Click to remove options. 

4 Click on the Page Setup Dialog Box Launcher  to display ..................................................  

 ................................................................................................................................................  

5 Ensure the Margins tab is displayed 

(You will notice there is an Orientation section with the same options as the  button 
in the Page Setup group on the ribbon.) 

6 Click on Cancel.   

7 Click on the  tab. 

 

 EXERCISE 3 
 

1 Type the text shown below onto your screen using the following instructions: 

a To type the heading in uppercase first press the Caps Lock key.   

b Type: ONLINE AUCTIONS  

c Press the Caps Lock key to turn off uppercase typing. 

d Press Enter twice to insert a blank line. 

e For an initial uppercase letter, eg the A of An, hold down the Shift key on the opposite 
side of the keyboard to the letter you are going to type, ie hold down the right Shift 
key, type A then release the Shift key.  Continue typing the remainder of the word. 

(The Shift key is also used to type the top symbols on the keys showing two symbols.) 

f Type the remaining text.  Leave any typing errors; you will correct these in Exercise 7.  
Do not press Enter at the end of each line as the text will automatically wrap to the 
next line.  (Enter is pressed once for a new line or twice for a new paragraph.) 

 
 
 
ONLINE AUCTIONS 

 

An online auction business is a web site where participants bid for products and services over 
the Internet. The process of buying and selling in an auction format is made possible through 
auction software which regulates the various processes involved. 

 
 

 

  

uppercase 
=  capital 
letters  

Sa
m

pl
e D

oc
um

en
t

http://en.wikipedia.org/wiki/Product_(business)
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Saving a document 

Generally you will save every document you create with a unique name (called the “file name”) 
so you can recall it to the screen for editing, formatting or printing at a later time.  (Keep file 
names simple and relevant to the document.  You can use letters and numbers, hyphen and 
underscore.) 
 

 EXERCISE 4 

1 Click on the Save button  on the Quick Access Toolbar   at the top 
left of your screen.   

 

The Quick Access toolbar may be displayed under the ribbon. 
 

Alternatively you can click on the  tab then on . 
 

The heading becomes the file name for your document, ie ONLINE AUCTIONS (OR you can 
type another file name on top of the given file name).  

2 Click on the EW Word 2013 Level 1 Exercise Files folder, ie.   

(You may need to click on  then on  first.) 

 

3 Click on .  The file name is now displayed at the top of the screen, ie ONLINE 
AUCTIONS – Word. 

 

Once your workbook has been saved pressing Ctrl S will save an updated version of the file. 

  

Ctrl S 
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Naming Files 

You will find it useful to use a system for naming files so you can locate them easily at a later 
time.  The name should describe the file without being too long.   

Your company or organisation may already have a naming procedure in place, for example you 
may be required to add the date the document was created to the start or end of the file name.   

Microsoft Office allows up to 255 characters in a file name, and spaces can be included.  You 
cannot use the following characters in a file name: /  \  <  >  *  ;  :  "  ?  

 

Closing a document 

When you have finished with a document you need to close it.  This is done as follows. 

 EXERCISE 5 

1 Click on the  tab. 

2 Click on .   

If you haven’t saved any changes, you will be prompted to do so (as shown below). 
 

 
 

You would normally then click on . 

  

Ctrl W 
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Creating a new document 

Each time you want to create a new document you need to create a Blank document. 

In the following exercise you will create a new document, type text and correct basic spelling 
and grammatical errors. 
 

 EXERCISE 6 

1 Click on the  tab, on  then Blank document. 

2 Type the following text carefully, and exactly as shown below.   

2 Notice when you type The that it is corrected automatically. 

You will correct errors in steps 3-7 underneath. 
 

 

WHAT IS A TRIATHLON? 
 

A triathlon is an athlettick event that includes swimming, running, 

and cycling. Teh triathlete therefore must frocus his or her training on 

all three parts. Their are actually five different lengths of triathlons; 

they range from short and doable to crazy long. (press Enter) 

 

3 Position the mouse pointer in the middle of the word athlettick (which is displayed with 
a red wiggly line underneath) and click the right mouse button (referred to as “right-
clicking”) which displays the shortcut menu shown below. 

 

4 Click on the first option. 

5 Right-click on frocus and select the correct option. 

Notice that Teh has been corrected automatically.  

6 Correct any other errors you may have made. 

7 Correct Their are  by right-clicking and selecting the correct option, 
ie There are (the blue wiggly line underneath was not displayed until 
you pressed Enter at the end of the paragraph.) 

8 Save the document with the file name Triathlon.  (In the Save As dialog box simply type 
the file name Triathlon over the text displayed in the File name: box, ie WHAT IS A 
TRIATHLON? then click on Save.)   

9 Close the document by clicking on the  tab and selecting . 

  

Ctrl N 
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Opening a document 

A document is “opened” when you need to recall it to the screen, eg for editing.   

In the following exercise you will open the document called ONLINE AUCTIONS that you 
created on page 6. 
 

 EXERCISE 7 

1 Click on  then on .   

A list of Recent documents is displayed in Backstage view as shown below.  (Your files will 
differ from mine.) 

 

2 Click on the file name of the document required, ie ONLINE AUCTIONS 

(If the required document is not displayed on the Recent list click on  or on 

 if you have just started Word.  Locate the folder where the 
document is stored.  Click on the file name of the document required then click on 

) 
 

In the Open dialog box you can double click on a document to open it. 

 
3 Click at the end of the document.  

4 Press Enter twice to start a new paragraph. 

5 Correct any errors you may have made then type the following: 
 

The most common online auction web site in Australia is EBay and in New Zealand 
it is TradeMe. 

 

6 Click on the Save button  on the Quick Access Toolbar to save and replace the 
document. 

 
 

Ctrl O 
 

Ctrl End 
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Print Preview and Print 

Print Preview allows you to view your document before printing.  If you wish to return to your 
document for any reason, eg to make editing changes click on the Back button shown at the 
top left (see below). 
 

 EXERCISE 8 

1 Click on  then click on .   

A preview of how your document will appear when printed is shown to the right in 
Backstage view.  This area is called Print Preview.   

 

 

 

Print 
 

The Print option sends the document directly to the default printer which prints out a 
paper copy (ie “hard copy ”) of your document.  (When your document is displayed on 
screen it is referred to as “soft copy”.) 

2 Click on .  The document will be sent to the printer. 

3 Close the document. 
 

  

Print Preview 

Back button 

Ctrl P 
Enter 
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Open Dialog Box  

The Open dialog box is used to retrieve a document that is not displayed on the Recent list.  
The contents of a particular folder/drive are displayed and the appropriate document (file) can 
be selected.  You can then edit, print and format the document as required. 
 

 EXERCISE 9 

1 Click on  then click on .   
 

2 Click on  then on  . 
 

The EW Word 2013 Level 1 Exercise Files folder displays all the retrievable Word 
documents as well as documents that you create.   
 
 

If this folder is not displayed do the following: 

a Click on the  next to  under Libraries in the Navigation Pane.  A list of 
folders displayed in the Documents library will appear.   

b Click on the  next to  then on  .  

2 Click on  from the Change your view button  at the top of the dialog box and 

select . 

  

The dialog box displays: 

 The name of the active folder - currently EW Word 2013 Level 1 Exercise Files. 

 A list of files stored within the EW Word 2013 Level 1 Exercise Files folder. 

 The type of files currently selected, ie Word Documents. 
 

3 Click on the file name Africa then click on .  (To quickly open a file from the 
Open dialog box you can double click on the file name.) 

  

Navigation  
Pane 

Address bar - 
displays the 

current folder 

List of files stored 
within the active 

folder 

Change your 
view button 

Type of files 
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